
Levenhuk
Lite

Software

Rövidített telepítési és 
alkalmazási útmutató

HU



1. To run LevenhukLite you can either double-click the "     " shortcut on your desktop, 

OR

Open the Start menu in the bottom-left corner of the screen. Navigate to "Applications" -> "Levenhuk" and click 
LevenhukLite shortcut to run the application. 

If you wish to change the language of the application, you can press the Shift-P shortcut to access the Preferences, then 
choose the Misc tab and under Languages choose the desired language. This action requires restart. 

2. If the camera drivers have been installed correctly, the name of the camera will appear in the camera list. 

3. If the camera does not appear in the list, make sure it is properly plugged in via a USB cable and/or the camera drivers 
are installed correctly. 

If you need to reinstall the drivers, run the setup wizard on the installation CD and choose Install Camera Driver. 

LevenhukLite software allows you to view, save and edit images and video clips that you take with your Levenhuk cameras 
through a microscope or a telescope. Functions and operations described are valid for Windows-compatible application. For 
Mac and Linux versions, the set of available functions can change. Levenhuk reserves the right to modify or discontinue any 
product without prior notice.
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 LevenhukLite main window interface 

Toolbox tabs: 

Interface elements: 

Menu bar 
Contains all the action commands for the application. 

Toolbox panel 
Grants access to quick setup and editing tools. 

Workspace 
Contains all the opened images, ready for editing. 

Toolbox tabs 
Allow you to switch between different sets of tools for viewing and editing. 

Toolbar 
Contains buttons for the most commonly used actions.

LevenhukLite

Description

File manager. Allows you to quickly locate and open the desired image or video. 

A list of actions throughout the session. Allows you to browse and undo/redo certain 
actions. 

Allows you to see and measure the parameters of the opened file. 

Name 

Camera Camera options and editing tools. 

Folders

Undo/Redo

Measurements

Layer A list of active layers of the image.



Viewing 

You can edit the resulting image with Exposure & Gain, White Balance, Color 
Adjustment and other tools on the Camera tab of the toolbox.

Clicking on the camera name will allow you to see the live camera view on your 
PC monitor. A Video tab will appear in the workspace. 

Capturing an image 
Click the Frame button. The current view will be captured and the 
resulting image shown in a new workspace tab. Every time you click 
the Frame button, a new image is taken and shown in a new tab. 

Capturing a video 
Click the Video button. Choose the file format, a name for your video 
and the output folder. Upon confirming these selections the live feed 
from the camera will be saved as a video until you choose to stop it.  

Capturing camera views 

Editing the image 

Saving 
You can save one or several images on your hard drive by choosing the 
required option in the File menu. Choose between Save, Save as… or 
Batch Save. 

The following file formats are supported: 

Windows Bitmap (*.bmp,*.dib,*.rle)
JPEG (*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type (*.tft)

Measurements 
LevenhukLite has a wide array of measurement options for your 
images. By using one of the tools in the Measurements tab of the 
toolbox (which are also accessible through a Measurements section 
of the menu bar) you can measure specific parameters of the image. 
The shapes placed on the image are actually located on a separate 
layer and the saved image is not affected. All the Measurements 
tools are listed below. 



Rectangle Draws a rectangle from two points along a diagonal and shows its dimensions.

Tool Description 

Angle Measures the angle between two lines. 

Point Places a Label Pn point and gives you its x and y coordinates. 

Line > Arbitrary Line Draws a line between two points on a given layer. 

Line > Horizontal Line Draws a horizontal line between two points on a given layer.

Line > Vertical Line Draws a vertical line between two points on a given layer.

Parallel Draws two parallel lines and numbers them.

Vertical > Four points Draws two vertical lines and numbers them. 

Vertical > Three points Draws two lines, perpendicular to each other. 

RoundRect Draws a rounded rectangle and shows its height and width.

Circle > Center+Radius Draws a circle on a given layer, using the Center+Radius method.

Circle > Two Points Draws a circle on a given layer, using the Two Points method.
 

Circle > Three Points Draws a circle on a given layer, using the Three Points method.
 

Annulus Draws a ring (two circles with a common center) and shows its inner and outer 
radius.

Two Circles > Center+Radius Draws two circles (Center+Radius method) and a line connecting their centers. 
Shows the distance between these points.

Two Circles > Three Points Draws two circles (Three Points method) and a line connecting their centers. 
Shows the distance between these points.

Arc Draws an arc along three points and shows its length.

Text Places a textbox on the image. Upon entering the text, right-click to confirm the 
entry.

Polygon Using your mouse, place as many points as you need. Right-click to create a 
polygon.

Ellipse Draws an ellipse. 



Tool Description

Allows you to adjust the histogram of the image. But instead of working with three 
variables (i.e. highlights, shadows and midtones), you can edit any point on the 
curve in 0–255 range without affecting the other points. 

Curve…

Automatically decides the optimal values for highlights and shadows. Chooses the 
brightest and the darkest spots, considers them white and black, respectively, and 
changes the histogram accordingly.

Auto Level

Automatically changes the contrast values of the image. Especially effective when 
the image has a uniform hue. 

Auto Contrast 

Histogram shows the RGB values of the initial image and reassigns the values, 
equalizing them in the resulting image.

Histogram Equalization 

Allows you to make quick adjustments to the brightness and contrast of the whole 
image.

Brightness/Contrast… 

Changes the color values of the whole image.Color…

Allows you to adjust the values of HL (highlights), M (midtones) and S (shadows) 
within –100...100 range. You can only edit these values in 24-bit True Color images.

HMS…

Allows you to adjust the midtone values of the image. The higher the Gamma 
value, the darker the image.

Gamma…

Allows you to filter one of the colors from the image bitmap. By choosing Red, 
Green or Blue, the respective information will be filtered out and the resulting 
image will change accordingly (i.e. when filtering the Red value, only Green and 
Blue values will be shown, etc.).

Filter Color… 

Allows you to extract one of the colors from the image bitmap.Extract Color… 

Inverts the colors of the image, while constraining the proportions.Invert

Note that all the dimensions are shown in pixels by default. To choose a different unit (mm, nm, etc.) you have to enter the 
current image resolution. You can use a ruler tool for additional measurement precision. Enter the resolution in Image > 
Resolution… menu (e.g. 100,000 pixels/m).

The measurements of all the shapes on the image may be seen in View > Measurement Sheet menu.

Adjustments 
Choose Image > Adjust… 
All the image adjustment actions are listed below. 



Processing 
Process menu contains a number of image processing tools. The LevenhukLite tools are similar to any other graphics 
editing software. Below is a full list of actions in this menu. 

Tool Description

Opens the Stitch dialog that allows you to stitch several images into one.Stitch 

Opens the Filter dialog that allows you to apply one of many LevenhukLite filters to an 
image. Before trying it out, we recommend you to read up on convolution and 
morphological filters on various forums. You can also create custom filters, which can be 
accessed from the Filter tab. 

Filter...

Allows you to adjust the intensity levels of the image, thus increasing its contrast and 
display sensitivity in low light conditions.

Range…

  

 

 

Allows you to partition the image into multiple segments (superpixels), based on pixels 
similar in color, intensity or texture. Afterwards, you can either delete the superpixels from 
the image or remove the rest of the image. This is very effective when you want to remove 
the noise from the image, while keeping the main details.

Segmentation...

Allows you to simplify the image bitmap. If the grey level of a given pixel exceeds a certain 
threshold, it is turned white. If it doesn't, the pixel is turned black.

Binary… 



Additional tools may be used during editing. To gain access to these tools, install them in the Plugin menu. 

To customize the application, you can use the Options menu. Press F1 or click the Help menu to read the manual. 

 Plug-ins  

Settings 

Applies a filter that embosses the image. Emboss…

Colors a grayscale image, making it easier to understand.Pseudo Color... 

Creates a 3D representation of the given image.Surface Plot...

Displays a 2D-graph of pixel intensity along a certain line within the image.Line Profile... 

 Applies a filter that softens the image, making it less sharp.Diffuse...

 Applies a filter that grains the image, making it less sharp.Granulate...

 Creates a new image out of several opened images.Mosaic...

 Similar to creating a video, this process allows you to merge several images with different 
focus into one sharp image.

Fusion...

 Creates false-color composite images from grayscale images.Color Composite...



1. Chcete-li aplikaci LevenhukLite spustit, klikněte dvakrát na ikonu “     ” na ploše,

NEBO

Otevřete nabídku Start v levém dolním rohu obrazovky. Přejděte na „Aplikace“ -> “Levenhuk” a kliknutím na zkratku 
LevenhukLite spusťte aplikaci.

Chcete-li změnit jazyk aplikace, můžete stisknutím klávesové zkratky Shift-P přejít do nabídky Preferences (Předvolby), 
pak zvolte záložku Misc (Různé) a v položce Languages (Jazyky) zvolte požadovaný jazyk. Tato akce vyžaduje restart 
počítače.

2. Pokud byly správně nainstalovány ovladače kamery, objeví se v seznamu kamer její název.

3. Neobjeví-li se kamera v seznamu, ujistěte se, zda je správně připojen přes USB kabel a zda jsou správně instalovány 
její ovladače.

Softwarová aplikace LevenhukLite vám umožňuje prohlížení, ukládání a provádění úprav fotografií a videosekvencí, které 
jste pořídili přes mikroskop nebo teleskop pomocí fotoaparátu/kamery Levenhuk. Popsané funkce a činnosti platí pro 
aplikaci kompatibilní se systémem Windows. U verzí pro Mac a Linux může být nastavení dostupných funkcí odlišné. 
Společnost Levenhuk si vyhrazuje právo provádět bez předchozího upozornění úpravy jakéhokoliv výrobku, případně 
zastavit jeho výrobu.

LevenhukLite Stručný průvodce spuštěním CZ

Budete-li potřebovat znovu instalovat ovladače, spusťte průvodce instalací na instalačním disku CD a vyberte možnost  
Install Camera Driver (Instalovat ovladač kamery).

Spuštění aplikace

LevenhukLite



Okno hlavního rozhraní aplikace

Záložky panelu nástrojů:

Prvky rozhraní: 

Lišta nabídky
Obsahuje všechny příkazy k vykonávání činností aplikace. 

Panel nástrojů
Umožňuje přístup k rychlému nastavení a nástrojům pro úpravy.

Pracovní plocha
Obsahuje všechny otevřené snímky, připravené k úpravám. 

Záložky panelu nástrojů
Umožňují přepínání mezi různými sadami nástrojů pro prohlížení a úpravy.

Lišta nástrojů
Obsahuje tlačítka pro nejčastěji používané činnosti.

LevenhukLite

Popis

Správce souborů. Umožňuje rychlé nalezení a otevření požadovaného obrázku nebo 
videosekvence. 
Seznam činností provedených během relace. Umožňuje procházení a zrušení/opakované 
provedení některých činností.

Umožňuje prohlížení a měření parametrů otevřeného souboru.

Název

Camera (Kamera) Možnosti fotoaparátu/kamery a nástroje pro úpravy.

Folders (Složky)

Undo/Redo (Zpět/Opakovat)

Measurements (Měření)

Layer (Vrstva) Seznam aktivních vrstev obrázku.



Sledování

Výsledný obrázek můžete upravit pomocí nástrojů Exposure & Gain (Expozice a 
zisk), White Balance (Vyvážení bílé), Color Adjustment (Úpravy barev) a 
dalších nástrojů na záložce Camera panelu nástrojů. 

Po kliknutí na název kamery budete schopni na monitoru svého počítače sledovat 
aktuální záběr objektivu.  Na pracovní ploše se zobrazí záložka Video.

Snímání obrazu
Klikněte na klávesu Frame (Rámec). Provede se zachycení aktuálního 
pohledu a výsledný obrázek se zobrazí v nové záložce na pracovní 
ploše. Pokaždé, když kliknete na tlačítko Frame (Rámec), nasnímá se 
další obrázek a zobrazí se v nové záložce.

Zachycování videosekvencí
Klikněte na klávesu Video. Zvolte si formát souboru, název své 
videosekvence a výstupní složku. Po potvrzení těchto voleb se budou 
aktuální záběry kamery ukládat ve formě videoklipu, dokud se 
nerozhodnete snímání zastavit. 

Zachycování záběrů fotoaparátu/kamery

Úpravy fotografií

Ukládání
Na svůj pevný disk můžete uložit jednu nebo několik fotografií. Z 
nabídky File (Soubor) si vyberte požadovanou možnost. K dispozici 
máte možnosti Save (Uložit), Save as… (Uložit jako...) nebo Batch 
Save (Uložit v dávce).

Podporovány jsou následující formáty:

Windows Bitmap (*.bmp,*.dib,*.rle)
JPEG (*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type (*.tft)

Měření
Aplikace LevenhukLite nabízí celou řadu možností měření vašich 
snímků. Pomocí některého z nástrojů v záložce panelu nástrojů 
Measurements (Měření) (který je přístupný i z položky 
Measurements na liště nabídky) můžete měřit konkrétní parametry 
snímku. Tvary umísťované na obraz se ve skutečnosti nacházejí na 
samostatné vrstvě a na uložený snímek nemají vliv. V následující 
tabulce jsou uvedeny veškeré nástroje nabídky Measurements 
(Měření).



Nástroj Popis

Angle (Úhel) Měří úhel mezi dvěma čarami.

Point (Bod) Umístí značkovací bod Label Pn a uvede jeho souřadnice x a y.

Ellipse (Elipsa)

Line > Arbitrary Line 
(Čára > Libovolná čára)

Nakreslí čáru mezi dvěma body na dané vrstvě.

Line > Horizontal Line 
(Čára > Vodorovná čára)

Nakreslí vodorovnou čáru mezi dvěma body na dané vrstvě.

Line > Vertical Line 
(Čára > Svislá čára)

Nakreslí svislou čáru mezi dvěma body na dané vrstvě.

Parallel (Paralelní) Nakreslí dvě souběžné čáry a očísluje je.

Vertical > Four points 
(Svislá > Čtyři body) 

Nakreslí dvě svislé čáry a očísluje je.

Vertical > Three points 
(Svislá > Tři body)

Nakreslí dvě čáry, navzájem kolmé.

Rectangle (Obdélník) Nakreslí obdélník ze dvou bodů po diagonále a ukáže jeho rozměry.

RoundRect Nakreslí obdélník se zaoblenými rohy a ukáže jeho výšku a šířku.

Nakreslí elipsu.

Circle > Center+Radius 
(Kruh > Střed+poloměr) 

Pomocí metody Střed+poloměr nakreslí kruh na dané vrstvě.

Circle > Two Points (Kruh > Dva body) Pomocí metody Dvou bodů nakreslí kruh na dané vrstvě.
 

Circle > Three Points 
(Kruh > Tři body)

Pomocí metody Tří bodů nakreslí kruh na dané vrstvě.
 

Annulus (Mezikruží) Nakreslí prstenec (dva kruhy se společným středem) a zobrazí jeho 
vnitřní a vnější poloměr.

Two Circles > Center+Radius 
(Dva kruhy > Střed+poloměr)

Nakreslí dva kruhy (metodou Střed+poloměr) a čáru spojující jejich 
středy. Zobrazí vzdálenost mezi těmito body.

Two Circles > Three Points 
(Dva kruhy > Tři body)

Nakreslí dva kruhy (metodou Tří bodů) a čáru spojující jejich středy. 
Zobrazí vzdálenost mezi těmito body.

Arc (Oblouk) Nakreslí oblouk podél tří bodů a zobrazí jeho délku.

Text Umístí na obrázek textové pole. Po vložení textu kliknutím na pravé 
tlačítko myši potvrďte zadání.

Polygon (Mnohoúhelník) Pomocí myši zadejte tolik bodů, kolik potřebujete. Kliknutím 
na pravé tlačítko myši vytvoříte mnohoúhelník.



Nástroj Popis

Umožňuje vám upravit histogram obrázku. Ale místo práce se třemi proměnnými 
(tj. světlé partie, tmavé partie a střední tóny) můžete upravit libovolný bod na 
křivce v rozsahu 0–255, aniž byste ovlivnili jiné body.

Curve…(Křivka...)

Automaticky zvolí optimální hodnoty pro světlé a tmavé partie. Vybere nejjasnější a
nejtmavší body, definuje je jako bílou a černou a podle toho upraví histogram.

Auto Level (Automatická 
úroveň)

Automaticky změní hodnoty kontrastu obrázku. Jedná se o účinný nástroj zejména 
tehdy, má-li obrázek jednotný barevný tón. 

Auto Contrast 
(Automatický kontrast)

Histogram ukazuje hodnoty RGB výchozího obrázku a upraví je tak, aby byly ve 
výsledném obrázku vyvážené.

Histogram Equalization 
(Vyvážení histogramu)

Umožňuje vám provádět rychlé úpravy jasu a kontrastu celého obrázku.Brightness/Contrast… 
(Jas/kontrast...)

Změní hodnoty barvy u celého obrázku.Color…(Barva...)

Umožňuje vám upravit hodnoty HL (světlé partie), M (střední tóny) a S (tmavé 
partie) v rozmezí –100 až +100.  Tyto hodnoty můžete upravovat pouze u obrázků ve 
formátu 24-bitový True Color.

HMS…

Umožňuje vám upravit hodnoty středních tónů obrázku. Čím vyšší gamma, tím 
tmavší je obrázek. 

Gamma…

Umožňuje vám odfiltrovat jednu nebo několik barev z bitmapy obrázku. Po volbě 
Red, Green nebo Blue (červená, zelená nebo modrá) se odfiltrují příslušné 
informace a výsledný obrázek se příslušným způsobem změní (např. při odfiltrování 
červené barvy se zobrazí pouze zelená a modrá apod.).

Filter Color… 
(Filtrovat barvu...)

Umožňuje vám extrahovat jednu nebo několik barev z bitové mapy obrázku.Extract Color… (Extrahovat 
barvu...)

Invertuje barvy na obrázku, přičemž omezí proporce.Invert (Invertovat)

Nezapomeňte, že všechny rozměry se standardně uvádějí v obrazových bodech (pixelech). Pokud chcete použít jinou 
jednotku (mm, nm apod.), musíte zadat rozlišení aktuálního snímku. Pro další zpřesnění měření můžete použít nástroj 
pravítko. V nabídce Image > Resolution… (Obraz > Rozlišení) zadejte rozlišení (např. 100 000 pixelů/m).

Výsledky měření všech tvarů na obrazu si lze prohlédnout v nabídce View > Measurement Sheet (Zobrazení > Tabulka 
naměřených hodnot).  

Úpravy
Zvolte Image > Adjust… (Snímek > Upravit) 
V následující tabulce jsou uvedeny všechny činnosti úpravy obrázků.



Nástroj Popis

Otevře dialogové okno Stitch (Sloučení), které umožňuje spojit více obrázků do jednoho.Stitch (Sloučení)

Otevře dialogové okno Filter, které vám umožní aplikovat na obrázek jeden z mnoha filtrů 
aplikace LevenhukLite. Doporučujeme vám, abyste si před prvním použitím filtrů přečetli na 
různých fórech informace o konvoluci a morfologických filtrech. Můžete si vytvořit vlastní 
filtry, k nimž budete moci přistupovat ze záložky Filter. 

Filter... (Filtr...)

Umožňuje provádět úpravy úrovní intenzity obrázku, čímž se zvyšuje jeho kontrast a 
citlivost zobrazení ve špatných světelných podmínkách.

Range…(Rozsah...)

  

 

 

Umožňuje rozdělit obrázek na několik segmentů (superpixelů) na základě pixelů podobné 
barvy, intenzity nebo textury. Tyto superpixely pak můžete buď z obrázku smazat, nebo 
odstranit zbytek obrázku. Tato metoda je velmi účinná při odstraňování šumu z obrázku při 
zachování hlavních informací.

Segmentation... 
(Segmentace...)

Umožňuje zjednodušení bitové mapy obrázku. Pokud úroveň šedé u daného pixelu přesáhne 
určitou úroveň, změní se jeho hodnota na bílou. V opačném případě se pixel změní na černý.

Binary… (Binární...)

Zpracování
Nabídka Process (Zpracovat) obsahuje řadu nástrojů pro zpracování obrazu. Nástroje LevenhukLite jsou obdobné jako u 
každého jiného programu pro úpravu grafických souborů. V následující tabulce je uveden seznam činností v této 
nabídce.



Při úpravách lze použít i další nástroje. Chcete-li k nim získat přístup, proveďte jejich instalaci v nabídce Plugin (Zásuvný modul).

Aplikaci si můžete upravit dle svých potřeb pomocí nabídky Options (Nastavení). Stiskněte klávesu F1 nebo klikněte na 
nabídku Help (Nápověda) a přečtete si návod k použití.

 Zásuvné moduly 

Nastavení

Aplikuje filtr, který vytvoří reliéf obrázku. Emboss… (Reliéf...)

Vybarví obrázek, který je ve stupních šedi, díky čemuž se v něm snadněji orientuje.Pseudo Color... (Pseudo 
barva...)

Vytvoří trojrozměrnou reprezentaci daného obrázku.Surface Plot... (Povrchové
vykreslení...)

Zobrazí dvojrozměrný graf intenzity pixelů podél určité čáry v obrázku.Line Profile... (Profil čáry...)

 Aplikuje filtr, který obrázek změkčí, a sníží tak jeho ostrost.Diffuse... (Rozostření...)

 Aplikuje filtr, který do obrázku přidá zrnitost, a sníží tak jeho ostrost.Granulate... (Zrnitost...)

 Vytvoří nový obrázek z několika otevřených obrázků.Mosaic...(Mozaika...)

 Podobně jako při tvorbě videosekvence vám tento proces umožní sloučit několik obrázků s 
různým zaostřením do jednoho ostrého obrázku.

Fusion...(Sloučení...)

 Z obrázků ve stupních šedi vytvoří složené obrázky s nepravými barvami.Color Composite...(Skládání 
barev...)



1. So starten Sie LevenhukLite: Klicken Sie entweder doppelt auf die Verknüpfung        auf Ihrem Desktop, 

ODER

Öffnen Sie das Start-Menü unten links auf dem Bildschirm. Gehen Sie zu „Programme“ > „Levenhuk“ (Windows XP) bzw. 
„Alle Programme“ > „Levenhuk“ (Windows 7), und klicken Sie auf das LevenhukLite-Symbol, um die Anwendung zu starten.

Falls Sie die Sprache der Anwendung ändern möchten, drücken Sie Shift-P, um zu den Voreinstellungen zu gelangen, wählen 
Sie die Registerkarte Verschiedenes und stellen dort unter Sprache die bevorzugte Sprache ein. Für den Abschluss dieser 
Aktion ist ein Neustart der Anwendung notwendig.

2. Falls die Kameratreiber korrekt installiert wurden, wird der Name der Kamera in der Kameraliste angezeigt.

3. Erscheint die Kamera nicht in der Liste, stellen Sie sicher, dass die Kamera korrekt über ein USB-Kabel angeschlossen 
ist und die Kameratreiber korrekt installiert wurden.

Falls Sie die Treiber neu installieren müssen, starten Sie das Setup auf der Installations-CD und wählen Sie Install Camera 
Driver (Kameratreiber installieren).

Mit der LevenhukLite-Software können Sie Bilder und Videoclips anschauen, speichern und bearbeiten, die Sie mit Ihren 
Levenhuk-Kameras durch ein Mikroskop oder Teleskop aufgenommen haben. Die beschriebenen Funktionen und Abläufe 
betreffen die Windows-kompatible Anwendung. Der Funktionsumfang der Mac- und Linux-Versionen kann abweichen. 
Levenhuk behält sich das Recht vor, Produkte ohne vorherige Ankündigung zu modifizieren oder einzustellen.

Die Software ausführen

LevenhukLite Schnellstart-Anleitung DE

LevenhukLite



Elemente der Benutzeroberfläche: 

Menüleiste 
Beinhaltet alle Aktionen und Befehle für die Software.

Werkzeugpalette
Gewährt Zugang zu Schnell-Setup und Bearbeitungswerkzeugen.

Arbeitsbereich
Enthält alle geöffneten Bilder, die zum Bearbeiten bereitstehen.

Registerkarten der Seitenleiste
Erlauben den schnellen Wechsel zwischen den verschiedenen Werkzeugen zum Anzeigen und Bearbeiten.

Symbolleiste
Enthält Schaltflächen für die am häufigsten genutzten Aktionen.

Registerkarten der Seitenleiste:

LevenhukLite-Benutzeroberfläche

LevenhukLite

Beschreibung

Der Dateimanager erlaubt Ihnen, schnell das gewünschte Bild oder Video zu finden und zu 
öffnen. 

Zeigt eine Liste von Aktionen während der Sitzung. Sie können die Aktionen durchsuchen 
und einzelne Aktionen rückgängig machen bzw. wiederherstellen.

Hier können Sie die Parameter der offenen Datei anzeigen und messen.

Name

Kamera Kameraoptionen und Werkzeuge zum Bearbeiten.

Ordner

Rückgängig/
Wiederholen

Messung

Ebene Eine Liste der aktiven Ebenen des Bildes.



Anzeigen

Auf der Registerkarte Kamera der Seitenleiste stehen Werkzeugen wie 
Belichtung & Empfindlichkeit, Weiß-Abgleich, Farb-Abgleich und andere 
bereit, mit denen Sie das Bild bearbeiten können.

Klicken Sie auf den Kameranamen, um das Livebild der Kamera auf dem 
Bildschirm anzuzeigen. Auf der Arbeitsfläche erscheint eine Video-
Registerkarte.

Klicken Sie auf die Schaltfläche Schnappschuss. Die aktuelle Ansicht 
wird aufgenommen, und das erhaltene Bild wird in einer neuen 
Registerkarte des Arbeitsbereichs angezeigt. Jedes Mal, wenn Sie auf 
Schnappschuss klicken, wird ein neues Bild aufgenommen und in einer 
neuen Registerkarte angezeigt.

Ein Bild aufnehmen

Klicken Sie auf die Schaltfläche Video. Wählen Sie ein Format und 
einen Namen für Ihr Video sowie den Ausgabeordner aus. Wenn Sie 
die Auswahl bestätigen, wird der Livestream von der Kamera als 
Video gespeichert, bis Sie den Prozess stoppen. 

Ein Video aufnehmen

Kameraansichten aufnehmen

Speichern
Sie können ein oder mehrere Bilder auf der Festplatte speichern. 
Wählen Sie dazu die gewünschte Option im Menü Datei aus. Wählen 
Sie Speichern, Speichern unter… oder Batch Speichern.

Die folgenden Dateiformate werden unterstützt:

Windows-Bitmap (*.bmp, *.dib, *.rle)
JPEG (*.jpg, *.jpeg, *.jpe, *.jif, *.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite-Dateityp (*.tft)

Messung
LevenhukLite verfügt über eine große Palette an Messoptionen für 
Ihre Bilder. Mit den Werkzeugen in der Registerkarte Messungen der 
Werkzeugpalette (die auch über das Menü Messungen der 
Menüleiste zugänglich sind), können Sie spezifische Parameter des 
Bilds messen. Formen, die auf das Bild gelegt werden, befinden sich 
in einer separaten Ebene und verändern das gespeicherte Bild nicht. 
Nachstehend finden Sie alle Werkzeuge aus dem Menü Messungen.

Ein Bild bearbeiten



Rechteck Zeichnet anhand von Eckpunkten in einer Diagonale ein Rechteck und zeigt seine 
Abmessungen an.

Werkzeug Beschreibung

Winkel Misst den Winkel zwischen zwei Linien.

Punkt Positioniert einen Label Typ Punkt und gibt Ihnen seine x- und y- Koordinaten.

Linie > Beliebige Linie Zieht eine Linie zwischen zwei Punkten auf einer Ebene.

Linie > Horizontale Linie Zieht eine horizontale Linie zwischen zwei Punkten auf einer Ebene.

Linie > Vertikale Linie Zieht eine vertikale Linie zwischen zwei Punkten auf einer Ebene.

Parallele Zeichnet zwei parallele Linien und nummeriert sie.

Vertikal > Vier Punkte Zeichnet zwei vertikale Linien und nummeriert sie.

Vertikal > Drei Punkte Zeichnet zwei Linien, die senkrecht zueinander stehen.

RoundRect Zeichnet ein abgerundetes Rechteck und zeigt seine Höhe und Breite an.

Kreis > Zentrum+Radius Zeichnet anhand von Mittelpunkt und Radius einen Kreis auf einer Ebene.

Kreis > Zwei Punkte Zeichnet anhand von zwei Punkten einen Kreis auf einer Ebene.
 

Kreis > Drei Punkte Zeichnet anhand von drei Punkten einen Kreis auf einer Ebene.
 

Ring Zeichnet einen Ring (zwei Kreise mit einem gemeinsamen Mittelpunkt) und zeigt 
seinen inneren und äußeren Radius an.

Zwei Kreise > Zentrum+Radius Zeichnet zwei Kreise anhand von Mittelpunkt und Radius und eine Linie, die ihre 
Mittelpunkte verbindet. Zeigt den Abstand zwischen diesen Punkten an.

Zwei Kreise > Drei Punkte Zeichnet zwei Kreise anhand von je drei Punkten und eine Linie, die ihre 
Mittelpunkte verbindet. Zeigt den Abstand zwischen diesen Punkten an.

Bogen Zeichnet einen Bogen entlang von drei Punkten und zeigt seine Länge an.

Text Positioniert ein Textfeld auf dem Bild. Geben Sie Text ein und bestätigen Sie mit 
einem Rechtsklick.

Polygon Platzieren Sie mit der Maus so viele Punkte wie nötig. Klicken rechts, um ein 
Polygon zu erstellen. 

Ellipse Zeichnet eine Ellipse.

Beachten Sie, dass alle Abmessungen standardmäßig in Pixel angezeigt werden. Um eine andere Einheit auszuwählen (mm, 
nm etc.) müssen Sie die aktuelle Bildauflösung eingeben. Sie können ein Lineal-Werkzeug benutzen, um die Messpräzision 
zu erhöhen. Geben Sie die Auflösung im Menü Bild > Auflösung… ein (z. B. 100.000 Pixel/m).



Die Messungen aller Formen auf dem Bild können unter Ansicht > Messwerte Tafel eingesehen werden. 

Bildeinstellungen
Wählen Sie Bild > Einstellen… 
Hier eine Liste aller Werkzeuge zum Anpassen der Bildeinstellungen.

Werkzeug Beschreibung

Erlaubt Ihnen, das Histogramm des Bilds anzupassen. Statt der Arbeit mit drei 
Variablen zu arbeiten (Höhen, Schatten und Mitten), können Sie jeden beliebigen 
Punkt auf der Kurve auf einer Skala zwischen 0 und 255 bearbeiten, ohne dass die 
anderen Punkte beeinflusst werden.

Kurve...

Bestimmt automatisch die optimalen Werte für Höhen und Schatten. Wählt die 
hellste und die dunkelste Stelle im Bild und betrachtet diese als weiß bzw. schwarz 
und verändert das Histogramm entsprechend.

Auto Stärke
 

Ändert automatisch den Kontrastwert des Bildes. Diese Funktion ist dann besonders 
effektiv, wenn das Bild einen einheitlichen Farbton hat. 

Auto-Kontrast

Das Histogramm zeigt die RGB-Werte des Originalbildes und weist die Werte neu zu, 
wobei es die Werte im Ergebnisbild angleicht.

Histogramm Angleichung

Erlaubt schnelle Anpassungen von Helligkeit und Kontrast des gesamten Bildes.Helligkeit/Kontrast...

Ändert die Farbwerte des gesamten Bildes.Farbe...

Erlaubt die Anpassung der Werte HL (Höhen), M (Mitten) und S (Schatten) auf einer 
Skala von –100 bis 100. Sie können diese Werte nur bei Bildern in 24-Bit-Echtfarbe 
bearbeiten.

HMS…

Erlaubt die Anpassung der Mittelton-Werte des Bildes. Je höher der Gamma-Wert 
ist, desto dunkler ist das Bild. 

Gamma…

Sie können eine der drei Farben des Bildes filtern. Wählen Sie Rot, Grün oder Blau. 
Die jeweiligen Bildinformationen werden herausgefiltert, wodurch sich das 
resultierende Bild entsprechend verändert (d. h., wenn der Rot-Wert 
herausgefiltert wird, werden nur Grün- und Blauwerte gezeigt usw.). 

Filter Farbe...

Gestattet Ihnen, eine der drei Farben aus dem Bild zu extrahieren.Farbe extrahieren...

Kehrt die Farbe des Bildes um, während die Proportionen beibehalten. Farbe umkehren



Bearbeitung
Das Prozess-Menü enthält eine Reihe fortgeschrittener Bildbearbeitungswerkzeuge. Die Werkzeuge von LevenhukLite 
ähneln den Werkzeugen anderer Grafikbearbeitungsprogramme. Nachstehend eine vollständige Liste aller Befehle aus 
diesem Menü.

Werkzeug Beschreibung

Öffnet den Zusammenfügen-Dialog, in dem Sie mehrere Bilder zu einem Bild zusammenfügen 
können.

Zusammenfügen

Öffnet den Filter-Dialog, in dem Sie einen von vielen LevenhukLite-Filtern auf das Bild 
anwenden können. Bevor Sie dies ausprobieren, empfehlen wir Ihnen, sich über 
Faltungsfilter und morphologischen Filtern zu belesen. Sie können auch benutzerdefinierte 
Filter erstellen, auf welche über die Registerkarte Filter zugegriffen werden kann.

Filter...

Erlaubt die Anpassung der Intensitätsstufen des Bildes, wodurch Kontrast und Helligkeit bei 
schlechten Lichtverhältnissen verbessert werden.

 Bereich...

  

 

 

Erlaubt Ihnen, das Bild auf der Basis von ähnlicher Farbe, Intensität oder Textur in mehrere 
Segmente (Superpixel) zu zerlegen. Anschließend können Sie diese Superpixel entweder aus 
dem Bild löschen oder den Rest des Bildes entfernen. Das ist sehr effektiv, wenn Sie 
Bildrauschen entfernen möchten, jedoch die Hauptdetails beibehalten möchten.

Segmentation & Count...

Reduziert die Farbtiefe des Bildes. Wenn ein Pixel eine bestimmte Graustufe überschreitet, 
wird er weiß gemacht. Andernfalls wird er schwarz gemacht.

Binary…



Wendet einen Filter an, der aus dem Bild ein Relief prägt.  Relief…

Färbt ein Graustufen-Bild, wodurch es besser interpretiert werden kann.Pseudo-Farbe...

Erstellt eine 3D-Darstellung des Bildes.Oberflächen Pilot...

Zeigt eine 2D-Auftragung der Pixelintensität entlang einer Linie im Bild.Linien-Profil...

 Wendet einen Filter an, der ein Bild weichzeichnet und dadurch weniger scharf macht.Diffus...

 Wendet einen Filter an, der ein Bild körniger und dadurch weniger scharf macht.Granulate...

 Erstellt aus mehreren offenen Bildern ein neues Bild.Mosaik...

 Ähnlich wie beim Erstellen eines Videos können Sie mit diesem Prozess mehrere Bilder mit 
unterschiedlichem Fokus zu einem scharfen Bild kombinieren.

Fusion...

 Erstellt Falschfarbenbilder aus Graustufenbildern.Color Composite...

Bei der Bearbeitung können Zusatzwerkzeuge benutzt werden. Um Zugang zu diesen Werkzeugen zu erhalten, installieren 
Sie sie im Plug-in-Menü.

Nutzen Sie das Menü Options, um die Anwendung anzupassen. Drücken Sie F1 oder klicken Sie auf das Hilfe-Menü, um die 
Benutzeranleitung („Hilfe Inhalt“) zu lesen.

Plug-ins

Voreinstellungen



1. Para arrancar LevenhukLite puedes hacer doble clic en el acceso directo “     ” de tu escritorio, 

O

Abre el menú Inicio en la esquina inferior izquierda de la pantalla. Navega hasta "Programas" -> "Levenhuk" y haz clic en el 
icono de LevenhukLite para arrancar la aplicación.

Si quieres cambiar el idioma de la aplicación puedes pulsar la tecla Mayús+P para acceder a Preferencias, elegir la pestaña 
Varios y dentro de Idiomas escoger el idioma deseado. Esta acción requiere reiniciar el programa.

2. Si los controladores de la cámara se han instalado correctamente, el nombre de la cámara aparecerá en la lista.

3. Si la cámara no aparece en la lista, asegúrate de que está conectada con un cable USB y de que los controladores de la 
cámara se han instalado correctamente.

Si tienes que volver a instalar los controladores, ejecuta el asistente de configuración del CD de instalación y elige 
Instalar controladores de la cámara.

El software LevenhukLite te permite observar, guardar y editar imágenes y clips de vídeo tomados con las cámaras 
Levenhuk a través de un microscopio o telescopio. Las funciones y operaciones descritas son válidas para la aplicación 
compatible con Windows. Para las versiones de Mac y Linux pueden cambiar las funciones disponibles. Levenhuk se reserva 
el derecho a modificar o retirar cualquier producto sin previo aviso.

LevenhukLite Guía de inicio rápido ES

Arranque de la aplicación

LevenhukLite



Elementos de la interfaz: 

Barra de menús 
Contiene todos los comandos de acciones de la aplicación.

Panel de herramientas
Sirve para acceder a las herramientas de configuración rápida y edición.

Espacio de trabajo
Contiene todas las imágenes abiertas, listas para su edición.

Pestañas de herramientas
Te permiten cambiar entre varios conjuntos de herramientas para ver y editar.

Barra de herramientas
Contiene botones para las acciones usadas más habitualmente.

Pestañas de herramientas:

Interfaz de la ventana principal de LevenhukLite 

LevenhukLite

Descripción

Gestor de archivos. Te permite localizar y abrir rápidamente la imagen o vídeo 
deseado.
 
Lista de las acciones realizadas durante la sesión. Te permite encontrar y hacer o rehacer 
ciertas acciones.

Nombre

Cámara Opciones y herramientas de edición de la cámara.

Carpetas

Deshacer/Rehacer

Te permite ver y medir los parámetros del archivo abierto.Mediciones

Capa Lista de las capas activas de la imagen.



Ver

Puedes editar la imagen resultante con Exposición & Ganancia, Balance de 
blancos, Ajuste del color y otras herramientas en la pestaña Cámara de la 
caja de herramientas.

Si haces clic en el nombre de la cámara podrás ver en la pantalla del ordenador 
en directo lo que se ve por la cámara. En el espacio de trabajo aparecerá una 
pestaña llamada Vídeo.

Haz clic en el botón Encuadre. La vista actual quedará capturada y se 
mostrará la imagen resultante en una nueva pestaña en el espacio de 
trabajo. Cada vez que haces clic en el botón Encuadre se toma una 
nueva imagen y se muestra en una nueva pestaña.

Captura de imágenes

Haz clic en el botón Vídeo. Elige el formato del archivo, un nombre 
para el vídeo y la carpeta de destino. Una vez confirmadas estas 
selecciones, la imagen en directo de la cámara se guardará como un 
vídeo hasta que lo detengas.

Captura de vídeo

Captura de imágenes de la cámara

Guardar
Puedes guardar una o varias imágenes en tu disco duro si eliges la 
opción requerida en el menú Archivo. Elige entre Guardar, 
Guardar como... o Guardar por lotes.

Se pueden utilizar los siguientes formatos:

Windows Bitmap(*.bmp,*.dib,*.rle)
JPEG(*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics(*.png)
Tag Image File Format(*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX(*.pcx)
Targa(*.tga)
JBIG(*.jbg)
LevenhukLite File Type(*.tft)

Mediciones
LevenhukLite tiene un amplio surtido de opciones de medición para 
tus imágenes. Al usar una de las herramientas en la pestaña 
Mediciones de la caja de herramientas (a la que también se puede 
acceder a través de la sección Mediciones de la barra de menús) 
puedes medir parámetros específicos de la imagen. Las formas 
situadas sobre la imagen se encuentran en una capa distinta y las 
imágenes guardadas no se ven afectadas. Todas las herramientas de 
Mediciones se enumeran a continuación:

Edición de imagen



Herramienta Descripción

Ángulo Mide el ángulo entre dos líneas.

Punto Sitúa un punto Etiqueta Pn y te da sus coordenadas x e y.

Línea > Línea arbitraria Dibuja una línea entre dos puntos en una capa concreta.

Línea > Línea horizontal Dibuja una línea horizontal entre dos puntos en una capa concreta.

Línea > Línea vertical Dibuja una línea vertical entre dos puntos en una capa concreta.

Paralelas Dibuja dos líneas paralelas y las numera.

Vertical > Cuatro puntos Dibuja dos líneas verticales y las numera.

Vertical > Tres puntos Dibuja dos líneas perpendiculares entre sí.

Rectángulo Dibuja un rectángulo a partir de dos puntos en una diagonal y muestra sus 
dimensiones.

RectRedondeado Dibuja un rectángulo redondeado y muestra su alto y ancho.

Círculo > Centro+Radio Dibuja un círculo en una capa concreta usando el método de Centro+Radio.

Círculo > Dos Puntos Dibuja un círculo en una capa concreta usando el método de Dos Puntos.
 

Círculo > Tres puntos Dibuja un círculo en una capa concreta usando el método de Tres puntos.
 

Corona circular Dibuja un anillo (dos círculos concéntricos) y muestra su radio interior y exterior.

Dos círculos > Centro+Radio Dibuja dos círculos (método de Centro+Radio) y una línea conectando sus centros. 
Muestra la distancia entre estos puntos.

Dos círculos > Tres puntos Dibuja dos círculos (método de Tres puntos) y una línea conectando sus centros. 
Muestra la distancia entre estos puntos.

Arco Dibuja un arco a lo largo de tres puntos y muestra su longitud.

Texto Sitúa un cuadro de texto en la imagen. Cuando introduzcas el texto haz clic con el 
botón derecho para confirmar la entrada.

Polígono Con el ratón, sitúa tantos puntos como necesites. Haz clic con el botón derecho 
para crear un polígono. 

Elipse Dibuja una elipse.

Recuerda que todas las dimensiones se muestran por defecto en píxeles. Para elegir una unidad distinta (mm, nm, etc.) 
debes introducir la resolución actual de la imagen. Puedes usar la herramienta de la regla para lograr una mayor precisión 
de las medidas. Introduce la resolución en el menú Imagen > Resolución… (p. ej. 100 000 píxeles/m).



Las medidas de todas las formas de la imagen se pueden ver en el menú Vista > Tabla de mediciones. 

Ajustes
Elige Imagen > Ajustar… 

A continuación se enumeran todos los ajustes de imagen.

Te permite ajustar el histograma de la imagen. Pero en lugar de trabajar con tres 
variables (luces, sombras y tonos medios) puedes editar cualquier punto de la curva 
en el rango entre 0 y 255 sin afectar al resto de puntos.

Curva…

Decide automáticamente los valores óptimos de luces y sombras. Elige los puntos 
más brillantes y los más oscuros, los considera blanco y negro, respectivamente, y 
cambia el histograma en consecuencia.

Nivel automático
 

Cambia los valores de contraste de la imagen automáticamente. Resulta 
especialmente efectivo cuando la imagen tiene un tono uniforme. 

Contraste automático

El histograma muestra los valores RGB de la imagen inicial y reasigna los valores 
ecualizándolos en la imagen resultante.

Ecualización del histograma

Te permite realizar ajustes rápidos del brillo y el contraste de la imagen.Brillo/Contraste…

Cambia los valores del color de la imagen.Color…

Te permite ajustar los valores de HL (luces), M (medios tonos) y S (sombras) en el 
rango entre –100 y 100. Solo se pueden editar estos valores en imágenes True Color 
de 24 bits.

HMS…

Te permite ajustar los medios tonos de la imagen. A mayor valor Gamma, más 
oscura será la imagen.

Gamma…

Te permite filtrar uno de los colores del mapa de bits de la imagen. Al elegir Rojo, 
Verde o Azul, la información respectiva se filtra y la imagen resultante cambia 
(por ejemplo cuando se filtra el valor Rojo, solo se muestran los valores Verde y 
Azul, etc.). 

Filtro color…

Te permite extraer uno de los colores del mapa de bits de la imagen.Extraer color…

Invierte los colores de la imagen manteniendo las proporciones.Invertir

Herramienta Descripción



Herramienta Descripción

Abre la opción Combinar, que permite combinar varias imágenes en una.Combinar

Abre el menú Filtros que te permite aplicar uno de los numerosos filtros de LevenhukLite a 
la imagen. Antes de probarlo recomendamos que leas sobre los filtros de convolución y 
morfológicos en los foros. También puedes crear filtros personalizados, a los que puedes 
acceder en la pestaña Filtros.  

Filtros...

Te permite ajustar los niveles de intensidad de la imagen, incrementando su contraste y la 
sensibilidad de la pantalla en condiciones de poca luz.

Rango…

  

 

 

Te permite dividir la imagen en múltiples segmentos (superpíxeles) basándose en píxeles de 
color, intensidad o textura similares. Después pueden borrarse los superpíxeles de la imagen 
o borrar el resto. Esto es muy efectivo cuando se quiere eliminar el ruido de la imagen y 
mantener los detalles principales.

Segmentación...

Te permite simplificar el mapa de bits de la imagen. Si el nivel gris de un píxel concreto 
supera cierto límite se vuelve gris. Si no, se vuelve negro.

Binario…

Procesado
El menú de Procesado contiene numerosas herramientas para procesar imágenes. Las herramientas de LevenhukLite son 
similares a las de cualquier otro programa de edición gráfica. A continuación, una lista completa de las acciones del 

menú.



Durante la edición se pueden usar herramientas adicionales. Para acceder a estas herramientas, instálalas desde el menú 
Plugin.

Para personalizar la aplicación se puede usar el menú Opciones. Pulsa F1 o haz clic en el menú Ayuda para leer el manual.

Plugins

Ajustes

Aplica un filtro que graba la imagen.  Grabado…

Colorea una imagen en escala de grises y la hace más fácil de entender. Pseudo color...

Crea una representación 3D de la imagen.Plan de superficie...

Muestra un gráfico en dos dimensiones de la intensidad de los píxeles en una línea de la 
imagen.

Perfil de línea...

 Aplica un filtro que suaviza la imagen y la hace menos definida.Difuminar...

 Aplica un filtro que añade grano a la imagen y la hace menos nítida.Granular...

 Crea una nueva imagen a partir de varias imágenes abiertas.Mosaico...

 De forma similar a crear un vídeo, este proceso permite fundir imágenes similares con 
enfoque distinto en una imagen definida.

Fusión...

 Crea imágenes de compuesto de color falso a partir de imágenes en escala de grises.Composición de color...



LevenhukLite Rövidített telepítési és alkalmazási útmutató

A LevenhukLite szoftverrel a Levenhuk kamera segítségével készített képeket és videofelvételeket nézheti meg, mentheti 
el vagy szerkesztheti meg. A leírt funkciók és műveletek Windows-kompatibilis alkalmazások esetében érvényesek. A Mac-re 
vagy Linuxra vonatkozó verziók esetében az elérhető funkciók ettől eltérők lehetnek. A Levenhuk vállalat fenntartja a 
jogot, hogy bármely termékét előzetes értesítés nélkül módosítsa vagy kivonja a forgalomból.

LevenhukLite

1. A LevenhukLite futtatásához kattintson duplán a számítógépe asztalán található „     ” parancsikonra 

VAGY

Nyissa meg a képernyő bal alsó sarkában található Start menüt. Lépjen az Applications (Alkalmazások) -> „Levenhuk” 
menüpontra, majd az alkalmazás futtatásához kattintson a LevenhukLite parancsikonra.

Ha módosítani szeretné az alkalmazás nyelvét, akkor a Preferences (Beállítások), menü eléréséhez nyomja meg a Shift-P 
billentyűkombinációt, majd válassza ki a Misc (Egyéb) fület, és a Languages (Nyelvek) opcióban állítsa be a kívánt 
nyelvet. Ennek a műveletnek a végrehajtásához újra kell indítani a számítógépet.

2. Amennyiben a kamera illesztőprogramjait megfelelően telepítették, akkor a kamera neve megjelenik a kamerák 
listájában.

3. Ha a kamera nem jelenik meg a listában, akkor ellenőrizze, hogy az megfelelően csatlakozik-e az USB-kábelen 
keresztül és/vagy a kamera illesztőprogramjait megfelelően telepítették-e.

Amennyiben újra kell telepítenie az illesztőprogramokat, futtassa le a telepítéshez adott CD beállítási varázslóját, majd 
válassza a IInstall Camera Driver (Kamera illesztőprogramjának telepítése) lehetőséget.

Az alkalmazás futtatása

LevenhukLite

HU



A LevenhukLite fő képernyőjének interfésze

Eszköztár fülei:

Név Leírás

Camera (Kamera) Kameraopciók és a szerkesztéshez használt eszközök.

Folders (Mappák) Fájlkezelő. Lehetővé teszi a kívánt kép vagy videó gyors megkeresését és megnyitását.

Undo/Redo (Művelet 
visszavonása/Művelet 
visszavonásának törlése)

A munkameneten keresztüli műveletek listája. Lehetővé teszi, hogy böngésszen az egyes 
műveletek között és visszavonja azt, vagy törölje a művelet visszavonását.

Measurements (Mérések) A megnyitott fájl paramétereit tekintheti és mérheti meg.

Layer (Réteg) A kép aktív rétegeinek listája.

Interfész elemek:

Menüsor
Tartalmazza az alkalmazás összes műveleti parancsát.

Eszköztár panel
A gyors beállításhoz és az egyes eszközök szerkesztéséhez nyújt hozzáférést.

Munkatér
A szerkesztésre kész megnyitott képeket tartalmazza.

Eszköztár fülei
A megtekintéshez és a szerkesztéshez választhat a különböző eszközök közül.

Eszközsor
A leggyakrabban használt műveletek gombjait tartalmazza.

LevenhukLite



Megteki

A létrejött képet az Exposure & Gain, White Balance, Color Adjustment 
(Expozíció és erősítés, a Fehéregyensúly, a Színbeállítás) vagy más 
eszközökkel is szerkesztheti az eszköztár Camera (Kamera) fülén.

A kamera nevére kattintással számítógépe monitorán élőben követheti a kamerát. 
A Video (Videó) fül jelenik meg a munkatérben.

Kép rögzítése
Kattintson a Frame (Keret) gombra. Az aktuális nézetet rögzíti a 
rendszer és az elkészült kép új munkatér fülön jelenik meg. Ahányszor 
a Frame (Keret) gombra kattint, a rendszer annyiszor rögzít új képet, 
amelyet mindig egy újabb fülön jelenít meg.

Videó rögzítése
Kattintson a Video (Videó) gombra. Válassza ki a fájlformátumot, a 
videó nevét, majd a kimeneti mappát. A fentiek jóváhagyásával a 
kamera élő felvételét videóként menti el a rendszer, amíg Ön a 
felvételt le nem állítja.

Felvételi kameranézetek

A kép szerkesztése

Mentés
A File (Fájl) menüben a kívánt opció kiválasztásával Ön egy vagy akár 
több képet is elmenthet a merevlemezre. Válasszon a Save, Save as 
(Mentés, Mentés másként) vagy a Batch Save (Csoportos mentés) 
opciók közül.

A rendszer az alábbi fájlformátumokat támogatja:

Windows Bitmap (*.bmp,*.dib,*.rle)
JPEG (*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type (*.tft)

Mérések
A LevenhukLite alkalmazás esetében a képekhez a mérési opciók 
széles kínálatából választhat. Az eszköztár (amelyet a menüsor 
Measurements (Mérések) részéből is elérhet) Measurements 
(Mérések) fülének egyik eszközével a kép különleges paramétereit is 
megmérheti. A képen elhelyezett formák egy másik rétegen 
találhatók, a mentett képet nem módosítják. A lentiekben találja a 
Measurements (Mérések) menüpont eszközeinek teljes listáját.



Eszköz Leírás

Angle (Szög) Két vonal által bezárt szöget mér.

Point (Pont) Elhelyez egy Label Pn (Címke Pt) pontot, majd megadja az x- és az y-koordinátát.

Ellipse (Ellipszis)

Line > Arbitrary Line 
(Vonal > Tetszőleges vonal)

Egy adott rétegen rajzol vonalat két pont között.

Line > Horizontal Line 
(Vonal > Vízszintes vonal)

Egy adott rétegen rajzol vízszintes vonalat két pont között.

Line > Vertical Line 
(Vonal > Függőleges vonal)

Egy adott rétegen rajzol függőleges vonalat két pont között.

Parallel (Párhuzamos) Két egymással párhuzamos vonalat rajzol és megszámozza őket.

Vertical > Four points 
(Függőleges > Négy pont)

Két függőleges vonalat rajzol és megszámozza őket.

Vertical > Three points 
(Függőleges > Három pont)

Két egymásra merőleges vonalat rajzol.

Rectangle (Téglalap) Átló mentén két pontból téglalapot rajzol és megjeleníti annak méreteit.

RoundRect (LekerekítettTéglalap) Lekerekített téglalapot rajzol és annak magasságát és szélességét jeleníti meg.

Ellipszist rajzol.

Circle > Center+Radius 
(Kör > Középpont+Sugár)

Egy adott rétegen kört rajzol a Center+Radius (Középpont+Sugár) módszer 
segítségével.

Circle > Two Points (Kör > Két pont) Egy adott rétegen kört rajzol a Two Points (Két pont) módszer segítségével.
 

Circle > Three Points 
(Kör > Három pont)

Egy adott rétegen kört rajzol a Three Points (Három pont) módszer segítségével.
 

Annulus (Gyűrű) Gyűrűt rajzol (két kört, amelyeknek ugyanaz a középpontja) és megjeleníti a belső 
és a külső sugár méretét.

Two Circlec > Center+Radius 
(Két kör > Középpont+Sugár)

Két kört rajzol (a Center+Radius (Középpont+Sugár) módszerrel) és egy vonallal 
összeköti a két kör középpontját. A pontok közötti távolságot mutatja meg.

Two Circles > Three Points 
(Két kör > Három pont)

Két kört rajzol (a Three Points (Három pont) módszerrel) és egy vonallal összeköti 
a két kör középpontját. A pontok közötti távolságot mutatja meg.

Arc (Ív) Ívet húz három pont között és megjeleníti annak hosszát.

Text (Szöveg) Szövegdobozt helyez el a képen. A jobb egérgomb kattintásával hagyhatja jóvá a 
bevitt szöveget.

Polygon (Sokszög) Helyezzen el annyi pontot az egérrel, amennyit csak szeretne. Sokszög 
létrehozásához kattintson a jobb egérgombbal.



Kérjük, vegye figyelembe, hogy a rendszer méretekhez használt alapértelmezett mértékegysége a pixel. Másik 
mértékegység (mm, nm stb.) választásához Önnek meg kell adnia az aktuális kép felbontását. A méretek további 
pontosításához a vonalzóként működő eszközt is igénybe veheti. A felbontást az Image > Resolution… (Kép > Felbontás...) 
menüpontban adhatja meg (pl. 100 000 pixel/m).

A kép egyes formáinak méreteit a View > Measurement Sheet (Nézet > Mérettáblázat) menüpontban találhatja meg.

Módosítások
Válassza az Image > Adjust… (Kép > Módosítás…) menüpontot.
A lentiekben találja meg a kép módosításához alkalmazható műveletek listáját.

Eszköz Leírás

Lehetővé teszi a kép hisztogramjának módosítását. Azonban a három változó 
(kiemelkedő, árnyékos és közepes tónusú területek) módosítása helyett a görbén 
megtalálható bármelyik pontot szerkesztheti a 0–255-ös tartományban anélkül, 
hogy ez a módosítást hatással lenne a többi pontra.

Curve… (Görbe...)

A rendszer automatikus módon dönti el a kiemelt és az árnyékos területek optimális 
értékeit. Kiválasztja a legvilágosabb és a legsötétebb pontokat, ezeket veszi 
fehérnek és feketének, majd ennek megfelelően módosítja a hisztogramot.

Auto Level (Automatikus szint)
 

Automatikusan módosítja a kép kontrasztértékeit. Különösen akkor működik 
hatékonyan, ha az egész képnek egységes a színárnyalata.

Auto Contrast (Automatikus 
kontraszt)

A hisztogram az eredeti kép RGB-értékeit mutatja és újból kiosztja az értékeket, 
kiegyenlítve őket a végső képen.

Histogram Equalization (Hisztogram 
kiegyenlítése)

Lehetővé teszi a teljes kép fényerejének és kontrasztjának gyors módosítását.Brightness/Contrast… 
(Fényerő/Kontraszt...)

Módosítja a teljes kép színértékeit.Color… (Szín...)

Lehetővé teszi az HL (F) fényes (H – highlights), a M (K) közepesen megvilágított 
(M – midtones) és az S (Á) árnyékos (S – shadow) területek értékeinek módosítását 
a –100...100-as tartományon belül. Ezeket az értékeket kizárólag 24 bites True 
Color típusú képek esetében módosíthatja.

HMS... (FKÁ...)

Lehetővé teszi a képen a közepesen megvilágított területek értékeinek 
módosítását. Minél nagyobb a Gamma (Gamma) értéke,annál sötétebb lesz a kép.

Gamma… (Gamma...)

Lehetővé teszi az egyik szín kiszűrését a bitmap képből. A Red, Green (Vörös, 
Zöld) vagy Blue (Kék) kiválasztásával a rendszer kiszűri a megfelelő információt és 
ennek megfelelően változik meg a végső kép (pl. a Vörös érték kiszűrésével 
kizárólag a Zöld és Kék értékek jelennek meg stb.).

Filter Color… (Színszűrő...)

Lehetővé teszi az egyik szín kivonását a bitmap képből.Extract Color… (Színkivonás...)

Megcseréli a kép színeit, miközben korlátozza az arányokat.Invert (Invertálás)



Feldolgozás
A Process (Feldolgozás) menü számos képfeldolgozási eszközt tartalmaz. A LevenhukLite eszközei ugyanolyanok, mint 
bármelyik grafikus képszerkesztő szoftver eszközei. A lentiekben a menüben található műveletek teljes listáját 
olvashatja

Eszköz Leírás

Megnyitja az Stitch (Egyesítés) párbeszédablakot, amelyben több képből hozhat létre 
egyet.

Stitch (Egyesétés)

Megnyitja a Filter (Szűrő) párbeszédablakot, amelyben a LevenhukLite számos filtere közül 
bármelyiket alkalmazhatja a képen. Mielőtt a szűrőket kipróbálná, tudjon meg többet a 
különböző fórumokon a konvolúciós és a morfológiai szűrőről. Egyéni szűrőt is létrehozhat, 
amelyet a Filter (Szűrő) fülön keresztül érhet el.

Filter... (Szűrő...)

Lehetővé teszi a képintenzitás szintjének beállítását, vagyis a kép kontrasztjának növelését 
és az érzékenység megjelenítését gyenge megvilágítási körülmények között is.

 Range… (Tartomány...)

  

 

 

Lehetővé teszi, hogy több szegmensre (szuperpixelekre) oszthassa a képet a hasonló színű, 
intenzitású vagy textúrájú pixelek szerint. Ezt követően Ön törölheti a szuperpixeleket a 
képről vagy eltávolíthatja a kép többi részét. Ez nagyon hatékony abban az esetben, ha a 
főbb részletek megtartása mellett ki akarja szűrni a zajt a képből.

Segmentation... 
(Szegmentálás...)

Lehetővé teszi a bitmap kép egyszerűsítését. Ha a megadott pixelek szürke szintje 
meghalad egy bizonyos értékhatárt, akkor fehérré változik. Ha nem akkor feketévé változik.

Binary… (Bináris...)



A rendszer olyan szűrőt alkalmaz, amely vízjelet helyez el a képen.Emboss… (Vízjel...)

Szürkeskálás képet színez meg, amelyet így könnyebben lehet értelmezni.Pseudo Color... (Pszeudo 
szín...)

Az adott kép 3D-s másolatát készíti el.Surface Plot... (Felületi 
kiterjedés...)

A kép egy meghatározott vonalának pixelsűrűségét jeleníti meg 2D-s grafikon formájában.Line Profile... 
(Vonalprofil...)

 Olyan szűrőt alkalmaz, amely lágyít a képen, így csökkenti annak élességét.Diffuse... (Diffúz...)

 Olyan szűrőt alkalmaz, amely szemcsésíti a képet, így csökkenti annak élességét.Granulate... (Szemcse...)

 Új képet hoz létre több, már megnyitott kép kombinációjából.Mosaic... (Mozaik...)

 A videofelvétel készítéséhez hasonlóan ez a művelet lehetővé teszi, hogy több eltérő 
fókuszú képet egyetlen éles képpé olvasszon egybe.

Fusion... (Fúzió...)

 Hamis színösszetételű képeket hoz létre szürkeskálás képekből.Color Composite... 
(Színösszetétel...)

A szerkesztés során további eszközöket vehet igénybe. Ezen eszközökhöz úgy juthat hozzá, ha telepíti őket a Plugin (Beépülő 
modul) menübe.

Az alkalmazás személyre szabásához használja az Options (Opciók) menüt. A használati útmutatóhoz nyomja meg az 
F1 billentyűt vagy kattintson a Help (Súgó) menüre.

 Beépülő  

Beállításo



1. Aby uruchomić program LevenhukLite, kliknij dwukrotnie skrót „     ” znajdujący się na pulpicie 

LUB

Otwórz menu Start w lewym dolnym rogu ekranu. Rozwiń menu „Aplikacje”, a następnie „Levenhuk”, po czym kliknij skrót 
programu LevenhukLite.

Jeżeli chcesz wybrać inny język aplikacji, wciśnij kombinację klawiszy Shift+P aby otworzyć panel Preferences 
(Preferencje), następnie wybierz kartę Misc (Różne) i wybierz pożądany język w polu Languages (Języki). Wprowadzenie 
tej zmiany wymaga ponownego uruchomienia programu.

2. Jeżeli sterowniki aparatu zostały zainstalowane poprawnie, jego nazwa pojawi się na liście urządzeń.

3. Jeżeli aparat nie jest widoczny na liście, upewnij się, że został on poprawnie podłączony za pomocą kabla USB, a 
sterowniki aparatu zostały poprawnie zainstalowane.

Jeżeli konieczna jest ponowna instalacja sterowników, uruchom kreator konfiguracji znajdujący się na instalacyjnej 
płycie CD i wybierz opcję Install Camera Driver (Zainstaluj sterownik aparatu).

Oprogramowanie LevenhukLite umożliwia wyświetlanie, zapisywanie oraz edycję obrazów i filmów wideo wykonanych za 
pomocą aparatów serii Levenhuk poprzez mikroskopy lub teleskopy. Opisane funkcje i czynności dotyczą aplikacji 
kompatybilnej z systemem Windows. Wersje dla systemów Mac i Linux mogą posiadać zmieniony zestaw dostępnych funkcji. 
Levenhuk zastrzega sobie prawo do modyfikowania lub zakończenia produkcji dowolnego produktu bez wcześniejszego 
powiadomienia.

LevenhukLite Skrócona instrukcja obsługi PL

Uruchamianie aplikacji

LevenhukLite



Elementy interfejsu: 

Pasek menu
Zawiera wszystkie polecenia dostępne w aplikacji.

Panel narzędzi
Umożliwia dostęp do narzędzi szybkiej konfiguracji i edycji.

Obszar roboczy
Zawiera wszystkie otwarte obrazy gotowe do edycji.

Karty panelu narzędzi
Umożliwiają przełączanie się pomiędzy różnymi zestawami narzędzi do wyświetlania i edycji plików.

Pasek narzędzi
Zawiera ikony najczęściej używanych poleceń.

Karty panelu narzędzi:

Interfejs okna głównego LevenhukLite

LevenhukLite

Opis

Menedżer plików. Umożliwia szybkie odnalezienie i otwarcie pożądanego obrazu lub 
filmu. 
 
Lista czynności wykonanych podczas trwającej sesji. Umożliwia ich przegląd, anulowanie 
oraz ponowne wykonywanie.

Nazwa

Camera (Aparat) Ustawienia aparatu i narzędzia do edycji.

Folders (Foldery)

Undo/Redo (Cofnij/Powtórz)

Umożliwia wyświetlenie i pomiar parametrów otwartego pliku.Measurements (Pomiary)

Layer (Warstwa) Lista aktywnych warstw obrazu.



Wyświetlanie

Możesz edytować widoczny obraz za pomocą narzędzi Exposure & Gain 
(Ekspozycja i wzmocnienie), White Balance (Balans bieli), Color Adjustment 
(Regulacja barw) oraz innych opcji dostępnych w karcie Camera (Aparat).

Kliknięcie nazwy aparatu umożliwia wyświetlenie przekazywanego na żywo 
obrazu na monitorze komputera. W obszarze roboczym pojawi się karta Video 
(Wideo).

Kliknij przycisk Frame (Kadr). Bieżący widok zostanie przechwycony i 
wyświetlony jako osobne zdjęcie w nowej karcie obszaru roboczego. 
Każde kliknięcie przycisku Frame (Kadr) powoduje przechwycenie 
kolejnego obrazu i wyświetlenie go w nowej karcie.

Przechwytywanie obrazu

Kliknij przycisk Video (Wideo). Wybierz format pliku, nazwę nowego 
filmu oraz folder docelowy. Po potwierdzeniu wybranych opcji obraz 
przekazywany na żywo z aparatu będzie zapisywany jako film dopóki 
nagrywanie nie zostanie zatrzymane. 

Nagrywanie filmu

Przechwytywanie obrazu z aparatu

Zapisywanie
Możesz zapisać jeden lub więcej plików na dysku twardym za 
pomocą odpowiedniej opcji w menu File (Plik). Wybierz jedną z 
opcji: Save (Zapisz), Save as… (Zapisz jako...) lub Batch Save (Zapis 
zbiorowy).

Obsługiwane są następujące formaty plików:

Windows Bitmap (*.bmp,*.dib,*.rle)
JPEG (*.jpg,*.jpeg,*.jpe,*.jif,*.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type(*.tft)

Pomiary
LevenhukLite posiada szeroką gamę opcji umożliwiających pomiar 
właściwości obrazu. Wybierając jedno z narzędzi w karcie 
Measurements (Pomiary) (które znaleźć można także w sekcji 
Measurements (Pomiary)) paska menu, możesz dokonać pomiaru 
konkretnego parametru obrazu. Kształty pojawiające się na 
powierzchni obrazu znajdują się na osobnej warstwie i nie 
zmieniają postaci zapisanego pliku. Wszystkie narzędzia znajdujące 
się w karcie Measurements (Pomiary) opisane są w tabeli poniżej.

Edycja obrazu



Narzędzie Opis

Angle (Kąt) Mierzy kąt pomiędzy dwoma liniami.

Point (Punkt) Umieszcza na obrazie punkt Label Pn oraz podaje jego współrzędne x i y.

Ellipse (Elipsa)

Line > Arbitrary Line 
(Linia > Linia dowolna)

Rysuje linię pomiędzy dwoma punktami na danej warstwie.

Line > Horizontal Line 
(Linia > Linia pozioma)

Rysuje linię poziomą pomiędzy dwoma punktami na danej warstwie.

Line > Vertical Line 
(Linia > Linia pionowa)

Rysuje linię pionową pomiędzy dwoma punktami na danej warstwie.

Parallel (Linie równoległe) Rysuje dwie równoległe linie i oznacza je numerami.

Vertical > Four points 
(Linie pionowe > Cztery punkty)

Rysuje dwie pionowe linie i oznacza je numerami.

Vertical > Three points 
(Linie pionowe > Trzy punkty)

Rysuje dwie prostopadłe do siebie linie.

Rectangle (Prostokąt) Rysuje prostokąt oparty na dwóch punktach przekątnej i wyświetla jego wymiary.

RoundRect (Prostokąt zaokrąglony) Rysuje zaokrąglony prostokąt i wyświetla jego wysokość oraz szerokość.

Rysuje elipsę.        

Circle > Center+Radius 
(Okrąg > Środek + promień)

Rysuje okrąg na danej warstwie za pomocą metody Center+Radius (Środek + 
promień).

Circle > Two Points (Okrąg > Dwa 
punkty)

Rysuje okrąg na danej warstwie za pomocą metody Two Points (Dwa punkty).
 

Circle > Three Points (Okrąg > Trzy 
punkty)

Rysuje okrąg na danej warstwie za pomocą metody Three Points (Trzy punkty).

Annulus (Pierścień kołowy) Rysuje pierścień kołowy (dwa okręgi o wspólnym środku) i wyświetla jego obwód 
wewnętrzny oraz zewnętrzny.

Two Circles > Center+Radius 
(Dwa okręgi > Środek + promień)

Rysuje dwa okręgi (metodą Center+Radius (Środek + promień)) oraz linię łączącą 
ich środki. Wyświetla odległość między obydwoma punktami.

Two Circles > Center+Radius 
(Dwa okręgi > Środek + promień)

Rysuje dwa okręgi (metodą Three Points (Trzy punkty)) oraz linię łączącą ich 
środki. Wyświetla odległość między obydwoma punktami.

Arc (Łuk) Rysuje łuk oparty na trzech punktach i wyświetla jego długość.

Text (Notatka tekstowa) Umieszcza pole tekstowe na obrazie. Po wprowadzeniu tekstu potwierdź zawartość
kliknięciem prawego przycisku myszy.

Polygon (Wielokąt) Nanieś pożądaną liczbę punktów za pomocą myszki. Zatwierdź utworzenie 
wielokąta kliknięciem prawego przycisku myszy. 



Pomiary wszystkich kształtów umieszczonych na obrazie można przeglądać w menu View > Measurement Sheet (Widok > 
Arkusz pomiaru).

Dostosowywanie
Wybierz Image > Adjust… (Obraz > Dostosuj...) 

Wszystkie polecenia dotyczące dostosowywania obrazu opisane są w tabeli poniżej.

Domyślną jednostką wyświetlania wymiaru jest piksel. Aby wybrać inną jednostkę (mm, nm itp.), należy wprowadzić 
bieżącą rozdzielczość obrazu. Dla większej precyzji pomiaru możesz użyć narzędzia linijki. Wprowadź rozdzielczość w menu 
Image > Resolution… (Obraz > Rozdzielczość...) (np. 100 000 pikseli/m).

Umożliwia dostosowanie histogramu obrazu. Zamiast regulacji trzech zmiennych 
(tj. podświetleń, cieni i półtonów), możesz edytować dowolne punkty na krzywej 
w zakresie 0–255 bez zmieniania pozostałych punktów.

Curve… (Krzywa)

Automatycznie dobiera optymalne ustawienia podświetleń i cieni. Odnajduje
najjaśniejsze i najciemniejsze punkty obrazu, traktuje.

Auto Level (Automatyczny poziom)

 
Automatycznie dobiera wartość kontrastu dla danego obrazu. Narzędzie to jest 
szczególnie skuteczne w przypadku obrazów o jednolitym odcieniu. 

Auto Contrast (Automatyczny 
kontrast)

Histogram wyświetla wartości RGB obrazu początkowego, po czym ustawia je 
ponownie, wyrównując wartości w obrazie końcowym.

Histogram Equalization (Wyrównanie 
histogramu)

Umożliwia szybkie dostosowywanie jasności i kontrastu całego obrazu.Brightness/Contrast… 
(Jasność/kontrast)

Zmienia wartości kolorów całego obrazu.Color… (Kolor)

Umożliwia dostosowanie wartości HL (highlights–podświetlenia), 
M (midtones–półtony) and S (shadows–cienie) w zakresie –100...100. Wartości te 
możesz zmieniać jedynie w obrazach o 24-bitowej głębi koloru (True Color).

HMS… (Podświetlenia, półtony i 
cienie)

Umożliwia dostosowanie wartości półtonów dla danego obrazu. Im wyższa jest 
wartość Gamma, tym ciemniejszy jest obraz. 

Gamma…

Umożliwia usunięcie jednego koloru z bitmapy obrazu. Po wyborze opcji Red 
(czerwony), Green (zielony) lub Blue (niebieski) dany kolor zostanie usunięty, 
a wyjściowy obraz odpowiednio zmieniony (np. po wyborze koloru czerwonego 
wyświetlane będą tylko wartości kolorów zielonego i niebieskiego). 

Filter Color… (Usuń kolor)

Umożliwia wyodrębnienie jednego koloru z bitmapy obrazu.Extract Color… (Wyodrębnij kolor)

Odwraca kolory obrazu, jednocześnie utrzymując proporcje.Invert (Odwróć)

 Narzędzie Opis



Przetwarzanie
W menu Process (Przetwarzanie) znajdują się narzędzia służące do przetwarzania obrazu. Narzędzia LevenhukLite są 
podobne do tych zastosowanych w innych programach do obróbki graficznej. Poniżej znajduje się opis wszystkich poleceń z 
tej kategorii.

Narzędzie Opis

Otwiera okno Stitch (Połącz), które pozwala połączyć kilka obrazów w jeden.Stitch (Połącz)

Otwiera okno Filter (Filtruj), które pozwala na zastosowanie jednego z wielu dostępnych 
filtrów programu LevenhukLite. Przed wypróbowaniem zalecamy poszerzyć na forach 
internetowych wiedzę na temat splotu oraz filtrów morfologicznych. Możesz także tworzyć 
własne filtry, które dostępne będą w karcie Filter (Filtruj).  

Filter... (Filtruj)

Umożliwia dopasowanie poziomu intensywności obrazu, tym samym zwiększając jego 
kontrast oraz czułość wyświetlacza przy słabym oświetleniu.

Range… (Zakres)

  

 

 

Umożliwia podział obrazu na wiele segmentów (superpikseli) na podstawie grup pikseli o 
podobnej barwie, intensywności lub teksturze. Następnie możesz usunąć poszczególne 
superpiksele lub pozostawić je, po czym usunąć całą resztę obrazu. Funkcja ta jest 
szczególnie skuteczna, gdy chcesz usunąć szumy z obrazu, zachowując jednocześnie główne 
detale.

Segmentation... 
(Segmentacja)

Pozwala na uproszczenie bitmapy obrazu. Jeżeli poziom szarości danego piksela przekroczy
ustalony próg, staje się on biały, a w przeciwnym razie – czarny.

Binary... (Obraz binarny)



Podczas edycji można wykorzystać dodatkowe narzędzia. Aby ich użyć, najpierw zainstaluj je w menu Plugin (Dodatki).

Aby spersonalizować aplikację, skorzystaj z menu Options (Opcje). Naciśnij przycisk F1 lub kliknij menu Help (Pomoc), aby 
przeczytać instrukcję.

Dodatki

Ustawienia

Nakłada filtr, który uwypukla obraz. Emboss... (Wytłoczenie)

Nakłada kolor na obraz w skali szarości, aby ułatwić jego właściwy odbiór.Pseudo Color... (Podgląd  
koloru)

Tworzy trójwymiarowe odwzorowanie danego obrazu.Surface Plot... 
(Wykres  płaszczyzny)

Wyświetla dwuwymiarowy wykres intensywności pikseli wzdłuż określonej linii na obrazie.Line Profile... (Profil 
liniowy)

Nakłada filtr zmiękczający obraz, tym samym zmniejszając jego ostrość.Diffuse... (Rozproszenie)

Nakłada filtr zwiększający ziarnistość obrazu, tym samym zmniejszając jego ostrość.Granulate... (Ziarnistość)

Tworzy nowy obraz z kilku otwartych obrazów.Mosaic... (Mozaika)

W sposób podobny do tworzenia filmu wideo, narzędzie to pozwala połączyć kilka obrazów o 
różnym stopniu ostrości w jeden ostry obraz.

Fusion... (Fuzja)

Przetwarza obrazy w skali szarości na kompozycje w barwach fałszywych.Color Composite... 
(Kompozycja barwna)



3. Если вы не видите камеру в списке, убедитесь, что она подключена к компьютеру с помощью USB-кабеля и что 
драйвер камеры правильно установлен.

Для установки драйвера камеры запустите программу инсталляции с прилагаемого диска и выберите Install Camera 
Driver (Установить драйвер камеры).

Основные элементы: 

Меню 
Содержит все команды управления программой.

Панель управления
Используется для оперативного управления и быстрой настройки.

Рабочее окно
Содержит все открытые изображения и используется для их обработки.

Вкладки панели управления
Позволяют переключать наборы инструментов и средств отображения.

Панель инструментов
Содержит кнопки для быстрого доступа к основным функциям.

Описание главного окна программы LevenhukLite

1. Чтобы запустить программу LevenhukLite на вашем персональном компьютере, дважды щелкните значок “     ” на 
рабочем столе Windows.

или

Нажмите кнопку Пуск в левом нижнем углу экрана. В раскрывшемся меню наведите указатель мыши на пункт 
«Программы», выберите папку «Levenhuk» и нажмите LevenhukLite, чтобы запустить программу. 

Если программа запустилась на английском языке, выберите меню Options->Preferences (Shift+P), затем в вкладке 
Misc найдите опцию Languages (Языки), установите Russian (Русский) и перезапустите программу.

2. При правильно установленном драйвере камеры ее название появится в списке.

Приложение LevenhukLite предназначено для просмотра, сохранения и обработки фото и видео, сделанных с 
помощью камер для телескопов и микроскопов Levenhuk. Описание работы и функций дано для приложения, 
совместимого с Windows. Для Mac и Linux набор доступных функций может меняться. Компания Levenhuk оставляет за 
собой право вносить изменения в функционал приложения или прекращать его производство без предварительного 
уведомления.

LevenhukLite Быстрый старт RU

Запуск программы

LevenhukLite



Вкладки панели управления:

LevenhukLite

Назначение

Менеджер файловой системы. Используется для быстрого поиска и открытия 
графических и видеофайлов.

Список выполненных операций. Позволяет просмотреть выполненные операции и
отменить их ошибочное или неточное выполнение.

Название

Камера Открывает панель управления камерой.

Папки

Отменить/Вернуть

Окно для просмотра и изменения параметров объектов.Параметры

Слой Открывает список активных слоев изображения.



Просмотр
Нажмите на название камеры для получения 
текущего изображения в режиме реального 
времени. В рабочем окне откроется вкладка Видео.

Для настройки изображения воспользуйтесь 
инструментами Выдержка и Усиление, Баланс 
белого, Настройка цвета и др. на вкладке 
управления Камера.

Получение изображения с камеры

Нажмите кнопку Кадр. Текущее изображение с 
камеры будет открыто в новой вкладке рабочего 
окна — это снимок изображения с камеры. При 
каждом нажатии кнопки получается новый снимок 
в новой вкладке.

Нажмите кнопку Видео. Выберите формат файла, 
задайте его название и рабочую папку, куда будет 
записываться видео, передающееся с камеры в 
реальном времени.

Захват кадра

Захват видео

Window Bitmap (*.bmp, *.dib, *.rle)
JPEG (*.jpg, *.jpeg, *.jpe, *.jif, *.jfif)
Portable Network Graphics (*.png)
Tag Image File Format (*.tif, *.tiff)
Compuserve GIF (*.gif)
PCX (*.pcx)
Targa (*.tga)
JBIG (*.jbg)
LevenhukLite File Type (*.tft)

Текущий кадр или группу кадров можно сохранить 
на диске с помощью команд меню Файл. Выберите 
Сохранить, Сохранить как или Сохранить 
пакетом.

Программа поддерживает сохранение в следующих 
форматах:

Сохранение изображения

Операции с изображением



Измерения
Программа LevenhukLite предоставляет широкие возможности для проведения различных измерений полученного изображения. Меню Измерения в 
основном используется для измерений изображения. Меню содержит команды для измерения различных геометрических фигур, накладываемых на 
изображение. Для выполнения измерений программа LevenhukLite истользует технологию Layer (Слой). Это позволяет сохранять исходное 
изображение в неизменном виде. Соответствующие средства находятся в панели инструментов или доступны через меню Измерения. Меню 
Измерения и его подменю описаны ниже.

Инструмент Описание

Угол Показывает угол между прямыми на изображении.

Точка Показывает точку Label Pn и ее координаты x и y на изображении.

Линия > Произвольная линия Рисует произвольную линию между двумя точками заданного слоя.

Линия > Горизонтальная линия Рисует горизонтальную линию между двумя точками заданного слоя.

Линия > Вертикальная линия Рисует вертикальную линию между двумя точками заданного слоя.

Параллель Отмечает и нумерует две параллельные линии.

По вертикали > Четыре точки Отмечает и нумерует две вертикальные линии.

По вертикали > Три точки Накладывает на изображение вторую линию перпендикулярно первой линии.

Прямоугольник Накладывает на изображение прямоугольник по двум точкам на диагонали и 
показывает его размеры.

Скругл.прямоуг. Рисует прямоугольник со скругленными углами, показывает его ширину и 
высоту.

Круг > Центр+радиус Рисует в указанном слое круг по методу Центр+Радиус.

Круг > Две точки Рисует в указанном слое круг по методу Две точки.

Круг >Три точки Рисует в указанном слое круг по методу Три точки.

Кольцо Рисует кольцо (два круга с общим центром), отображаются внешний и 
внутренний радиусы с указанием величины и единицы измерения.

Два Круга > Центр+радиус Рисует два круга и линию, соединяющую центры двух нарисованных кругов. 
Показывает расстояние между центрами кругов.

Два Круга >Три точки Рисует два круга по трем точкам и линию, соединяющую центры двух 
нарисованных кругов, отмечая расстояние.

Арка Соединяет три точки дугой с указанием метки длины дуги.

Текст Накладывает текст на изображение. Введите текст и нажмите правую кнопку 
мыши для завершения ввода.

Многоугольник Отметьте с помощью мыши первую точку многоугольника, затем вторую, третью 
и т.д. до n-й (последней) точки. Повторите шаги с 1 по n, чтобы нарисовать 
другой многоугольник. Нажмите правую кнопку мыши для завершения. 

Эллипс Рисует эллипс.



Инструмент Описание

Используется для настройки общей цветовой гаммы изображения. Вместо 
регулировки трех переменных (яркий участок, тень, средний тон) можно 
настраивать любую точку кривой в диапазоне от 0 до 255, сохраняя прочие 
значения неизменными. Для точной настройки цвета отдельных участков 
изображения можно также использовать опцию Кривая.

Уровни

Автоматически определяет оптимальные значения для ярких участков и тени. 
Определяет самый светлый и самый темный пиксели в каждом цветовом канале 
как белый и черный, а затем пропорционально перераспределяет цвета 
пикселей.

Автоуровни

Эффективен, когда изображению со средним распределением значений 
пикселей требуется простая регулировка контраста или когда у изображения 
есть общий оттенок.

Автоконтраст

Гистограмма отражает статистические данные по каналам RGB (красный,
зеленый, синий) для пикселей исходного изображения.

Выравнивание гистограммы

Позволяет легко настраивать тональный диапазон изображения. Применяет 
одни и те же настройки ко всем пикселям изображения.

Яркость/Контраст

Меняет всю совокупность цветов изображения.Цвет

Настраивает участи изображения HL (яркий), M (средний тон) и S (тень). 
Значение яркости каждого участка варьируется в диапазоне от –100 до 100. 
Данный инструмент применим только к изображениям с 24-разрядным 
кодированием цвета (естественный цвет — true color).

HMS

Измеряет яркость значений среднего тона, генерируемых устройством (часто 
монитором). Более высокое значение Гамма означает более темное 
изображение в целом. 

Гамма

Отфильтровывает из цветного изображения определенный цветовой канал. 
Выберите по очереди Красный, Зеленый или Синий цвет. Например, при 
выборе красного цвета для каждого пикселя будет отброшена только 
информация о красном канале, а информация о зеленом и синем каналах 
останется без изменения.

Фильтровать цвет

Извлекает из цветного изображения определенный цветовой канал.Извлечь цвет

Инвертирует значения пикселей активного изображения, не задействуя таблицу 
соответствий.

Инвертировать

Обратите внимание на то, что для показа размера объектов в выбранных единицах измерения (мм, нм и т.п.) 
нужно указать текущее разрешение изображения. Оно задается в меню Изображение->Разрешение. Для большей 
точности рекомендуем воспользоваться калибровочной линейкой, активировав ее в рабочем окне. Измерив 
эталонное расстояние по линейке, укажите его в программе, например 100 000 пикселей на метр.

Параметры всех объектов, наложенных на изображение, показываются в Листе измерений, доступном в меню 
Просмотр.

Настройка изображения
Выберите меню Изображение->Настроить
Перечисленные ниже операции используются для коррекции полученного изображения.



Обработка изображения
Меню Обработка содержит список операций, с помощью которых можно обработать изображение в текущем окне. 
Операции по обработке аналогичны используемым в других графических пакетах. Краткое описание приведено 
ниже.



Levenhuk, Inc. 924-D East 124th Ave. Tampa, FL 33612 USA
®Levenhuk  is a registered trademark of Levenhuk, Inc.

© 2006–2019 Levenhuk, Inc. All rights reserved.
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Внешние модули обработки изображения находятся в меню Плагин и позволяют провести дополнительные 
измерения, например быстрое преобразование Фурье.

Дополнительные операции

Для настройки программы воспользуйтесь меню Опции. Воспользуйтесь меню Справка или нажмите F1.

Настройки программы


